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Why Browsing in Nexsure Differs from Other Internet Sites

Nexsureisan Internetbased Management System and will have some of the same characteristics
as any Internet site has. With that being said, it is important to know what the differences
! are. !

1. Since Nexsure is a Management tool, this means that data is being passed to and from
the server via the Internet with each save and refresh. When data is being moved
back and forth to the server this will slow the refreshing of screens. Nexsure does not

! notify you each time data is being transmitted with popup screens but instead uses the !

! Internet progress indicator located on the status bar. w
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| 2. Typically users are accustomed to navigating with the Back and Forward buttons in 1
| Internet Explorer, but with Nexsure it is important not to use these navigation tools. |
i If used, it is possible that a Page Expired message will be returned. The navigation i
i buttons are blocked in this way to keep from duplicating a record that may have just ‘
been added. Nexsure always has a way within the program to navigate, eliminating the
need to use the Internet Explorer navigation buttons.
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i Clearing Temporary Internet Files w

| Web browsers store content from previously viewed sites in their Temporary Internet Files |
folder. This allows the browser to load a previously viewed page from a site without reloading
it. When using Nexsure it is important to clear these files periodically to make sure the new
screen information is shown rather than the old. To delete the Temporary Internet Files,
| perform the following steps: |

1. In Microsoft® Internet Explorer, go to the Tools menu
and select Internet Options

W Hexsure - Microsoft Intern =1 Explarer
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| . - | mcheonize., ..

; " - o Lipdate !
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| Pinefionrs Messenger |
| ow Related Links i
: nexsure _ ¢ :

It Cplans, .

| Dimensionsl: Page 2 6/2005 Issue 5 |

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,



Tiprs AND FAcCTs

Internet Options E| E|

|
| General |Seu:ur|t_l,l Privacy | Content | Connections || Programs || Advanced |
|
|

Haome page
% Y'ou can change which page to uze for your home page.

Address: | o L o 1) |

[ I1ze Current ] [ Ilze Default ] [ I1ze Blank, ]

Temporany Internet files

for quick. viewing later.

| 2. Click Delete Files [oetete-Eomke—p | Delete Files.. | [ Settings...

Hiztory
@ The History folder containz links to pages pou've vizited, for

‘ Pages you view on the [nternet are stared in a zpecial folder
ﬂ L

quick access to recently viewed pages.

D ayz to keep pages in histony: !EEI > | [ Clear Hiztory ]

[ Colors. .. ] [ Fonts... ] [ Languages... ] [.ﬁ.ccgssil:uilit_l,l...]

[ UK J[ Cancel ]

[ 3. Check the Delete all offline content box

l 4. Click OK Pl o | [ Carvel

| |
: Wait for the process to complete. When the hourglass is no longer present, the process is ;
| complete. :
| |
| |
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Clearing Local Desktop Temporary Files

i Sometimes it is necessary to clear the Temp file directory on your local desktop. Temporary ‘
i files are stored in the Temp file directory and may be inadvertently accessed when attempting \
| to access a newer file with the same name. To clear the Temp files directory, follow the steps |
‘ below: ‘

| [ 1. *Close all open applications |

[ 2. Right-click the Start menu

[ 3. Click on Explore

4. Verify that hidden files can be viewed.

a. Go to the Tools menu and select Folder Options

File

\ @ Back - > ?

Edit View Favorites Help
ap Metwork Drive. ..
isconnect Network Drive. ..

ynchronize. .
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Folder Options

‘ [
; . - — |
! b. Click the View tab Lm..;.ﬁ View |FlaT _ !
i [ il | e | Ypes B i
| |

Folder views

Y'ou can apply the view [zuch az Detailz or Tiles] that
wan are uzing for this falder o all falders.

-
=
-

| |
i : ) : i
| | Apply to &)l Folders | [ Beset All Folders |
| i

Advanced settings:

} I3 Files and Faolders A !
} Autormatically zearch for network folders and printers
|
|

Dizplay file zize information in folder tipz

Dizplay zimple folder wiew in Explorer's Folders hist
| ] Display the contents of system folders |
; Dizplay the full path in the address bar — ;
i ] Display the full path in the title bar i
| I

] Donot cache thumbnails

|3 Hidden files and folders

‘ ) Do not show hidden files and folders !
| (%) Show hidden files and folders i
i ] #¥de extensions for known file types b i
! c. Verify the Show hidden files | | — ] !
‘ and folders option is selected ‘
‘ under Hidden files and folders

[ Restore Defaulkz

[ OF. ][ Cancel ]

[ d. Click OK to close the window T
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The Windows Explorer view should be displayed.
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[ 5. Click on the Local Settings folder

L

)

[ 6. Double-click the Temp folder
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FavOrsg ]

| [ 7. Click Eclit‘I
| G Ursdo Dusbee CRrle T
Cut CErkEx
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| (8. Click select an_}
|

9. Click File BE Em fpaens s imp
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|
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10. Click Delete
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Windows® XP Service Pack 2 Settings

| Windows® XP Users with Service Pack 2: In order for Nexsure to run properly with |
Windows® XP Service Pack 2, some components are required. If these components have not
been installed correctly, you may experience the following issues:

= Downloads not functioning properly

= Batch Printing not functioning properly

= Components not being downloaded

= Being logged out when trying to do any of the above functions
= Pop-ups not displaying

= E-services not functioning properly

= Third party pop-up blocker installed (must be turned off or added to accept list for
Nexsure® to work properly)

i [ 1. Close all open applications |

| [ 2. Launch Microsoft® Internet Explorer |

‘ Inkternet ‘
\ Explarer \

| File  Edi

om0 Rk

| J Address I@j hkkps: | funsm mEssun
indows Messenger

nexsure
ahoo! Messenger

\ LOGIN | SUPPORT | SECUH isualRoute Trace

R Favarites 6-‘“| - .,_-,: E -

j “Links .&"[ Mexsure éjQ.ﬂ. Mexsure .E:[Intranet =

| ABOUT XDTI | XDTI HOME

Welcome to Nexsure., Please login.
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| The window will default to the General tab, click on the Security tab. |

Security Tab: 'Inmm Options 7% ‘

 Genetal| Secusty | Prvacy| Conlent | Connections | Program: | Advanced

| 1. Click on the Security tab Seiact 8 Web corfent zone bo o s ARG [ |

® €@ 0 @

rlh-rr-l Local rtiansd  Thasted sides Haﬁtlud

| 2. Click on the Internet icon
Internel

’ This zone cortams sl Wisb mles pou
| b placend i olfver 2o !

; Seciaty leved for thiz 2one ;

Cuslom

Curlom settrgs
! - T ehangs the satlings, ook Custom Leval !
| « To um the recommended seltings. cick Defaull Level i

3. Click Custom Level D Custcmlevel. | [ Detwiievel |

ok || Concel
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Security Settings

Setkings:

% .MET Framework-reliant components
% Fun components nok signed with Authenticode
() Disable
(%) Enable
{:}' Prompk
% Fun components signed with Authenticode
() Disable
(%) Enable
{:}' Prompk
@ Activer controls and plug-ins
@ Automatic prompting For Activel controls

[ 4. Ensure the custom setting is set to Medium ESE'E;'E
1=

<

[£

Reset custom settings

[ 5. Click the Reset button

rezerToP | Medium

v |

Reset |

T

Warning!

04

][ Cancel ]

Y "_q,‘ Are you sure vou want to change the security settings for this zone?
L

[ 6. Click Yes

P v [
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7. In the Settings list, set Automatic prompting for ActiveX controls and
Automatic prompting for file downloads to Enable.

@ Activer contrals and plug-ins
@ Autornatic prormpking For Activer conbrols
() Disable

‘ E Downloads ‘
(1% Autamatic prompting For file downloads

| () Disable |
| » (%) Enable 3 |
i [~ T ] [ PR R | B ] ;
i & 5 » i
| Reset cuskam setkings }
! |
‘ Resel bo !_Medium w I Reset | ‘
| e |
| |
| ; ; |
| 8. Click OK 4 R S Cancel | |

Warning!

| [ 9. Click Yes
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Select a'Web content zone to specify its securnity settings.

® Q@ 0 @

[Hternet Local intranet Restricted

Truzsted sites

* sites

[ 10. Click on the Trusted Sit

es icon -
Hrﬁusted zites

Thiz zone contains Web sites that you
trust not to damage your computer ar —
data. Mo sitez are in th@une.

ol 1L Ll

[ 11. Click the Sites button }

W |
b i

Custom
Custam zetings.
- To change the zettings, click Custom Lewvel.
- To uzge the recommended zettings, click Default Level.

[ Custom Lewvel... ] [ Default Level ]

| ok H Cancel ] Apiply
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' Trusted sites |?| &

You can add and remove Web sites From this zone. All Web sites
in this zane will use the zone's security setkings.

Add this Web site to the zone:

I MEXSUNE, com | [ Add

T S
[ 12. Enter nexsure.com el 5

[CIRequire server verification (htkps:) For all sites in this zones

13. Uncheck the Require [

server verification box ok | [ cafel |

[ 14. Click the Add button

nexsure.com will move down below to the Web sites window.

r Trusted sites I‘?l &

%ou can add and remove Web sites from this zone. all Web sites
in this zone will use the zone's security settings.

Add this \Web site to the zane:

Web sites:
I
| mexsure, com

[(]Require server verification (https:) For all sites in this zone

[ 15. Click oK b ok | [ cancsl |
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Internel Oplions

| Genetal | Secusy Privacy | Contant | Connections Program: | Advanced |

; 1. Click on the Privacy tab St ;
f Morem thee dhier bo selact & pirvacy sefting of the lnlemnel

| | - Blocks thisd pady cookies that da rob have & compac

! i | Difvacy policy !
| | = Blocks thid-pady cockies that wee personally identifabls |
! | | mbormnabon vwathoud pous Ephcal congen !
! | - Resticts frd-paty cookiss thal use pertonaly dentfisbie !
| | infoimalion wihoud imphcil conzent |

2. Click the Sites button
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tanage Sitez

e ‘f'oucan specify which Web sites are alwaps or never allowed to uze
=8  cookies, regardleszs of their privacy policy.

Type the eract addreszs aof the \Web site you want b manage, and then click Allow
or Block.

Toremowve a zite from the lizt of managed zitez, zelect the name of the \Web zite
and click the Remove buttan,

Address of Web site;
ine:-:sure.u:u:um | [ Block ]
b anaged “Web sites: T

[ 4. Click the Allow buttizl-—em. Cratia




tanage Sites

o 'ou can zpecify which Web zitez are always or never allowed to use
%8 cookies, regardless of their privacy policy.

Type the eract address of the ‘wWeb zite you want to manage, and then click allow
or Block.

Toremowve a zite from the lizt of managed zites. select the name of the \Web site
and click the Remowe button.

| ;
i Addreszs of Web site; ‘
| ' [ Block | i
‘ |
a |
| Managed 'eb sites: |
i D omain Setting ERm \
| RIERELINE, COMm Alwayps Sllow i
| -FI emaove Al i

[ 5. Click OK
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Settings

B taove the glider to select a privacy setting for the Interhet
8 zone
...................... N

privacy policy

- Blocks third-party cookies that use perzonally ide
‘—l infarmation withaut your implicit conzent

L - | - FRestricts first-party cookies that uze perzonally idgntifiable
information without implicit consent

- Blocks third-party cookies that do nat have a u:u:ur]pact

tifiable

[ Sites.. H Impart.... H.-'ldganc:ed...

Fop-up Blocker
@ Presvent most pop-up windows from appearing.

v

b ([Ertrree

Ok, H Cancel ]
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Pop-up Blocker Settings

Pop-upz are currently blocked. You can allow pop-ups from specific
YWeb zitez by adding the site to the list below,

|
} Exceptions
|

|

|

| Addrezs of \Web site to allow:

i ine:-:sure.u:u:um | [ Audd
|

* V'S

[ Enter nexsure.com oo
Allowed zites:

‘ Matifizations and Filker Lewvel

| Play a zound when a pop-up iz blocked.

i Show Information Bar when a pop-up iz blocked.
|

! I Click Add Filter Lewel
|

[Medium: Block most automatic pop-ups

|
i Pop-up Blocker FAQ
|
|

Make sure the above settings are set correctly on your machine.

[ Click the Close button

Rechmologios Page 18 6/2005 Issue 5




Removing Webupdate.Control and XDUpload.Upload

If experiencing OI or download issues, e-services not working properly, or for an initial setup
of a new workstation, perform all of the previous steps in this document and perform the
following steps for removing the Webupdate.Control and XDUpload.Upload components.

*IMPORTANT: First make sure to close all programs. Check Windows Task Manager
Processes to make sure all Office programs are closed and not just minimized. This would
include Outlook, Word and Excel. Also make sure Adobe® Reader® is not running as a process.
This can be done by holding down Ctrl-Alt-Del and clicking the Task Manager button. Once
the window appears, click on the Processes tab.

_Ioix]
File ©Options ‘iew Help
Applications  Processes IF‘erFDrmanceI Netwu:urkingi

Image Marme I ser Mame I _PU I Mem Lsage I =
Buggw . exe suardinij i 2,756 K
CoApp.EXE suardinij a0 1,160 K
ccEvEMgr.exe SYSTEM an 344 K
cCoetMagr.exe SYSTEM i} TZ4 K
cidaemon. exe SWSTEM oo 252 K
Cisve, exe SY¥STEM oo 140k
C5F55,BXE SYSTEM an 2,464 K
Defwatch,exe SYSTEM li] 300 K
explorer. exe suardinij i 11,636 K
lsass, exe SYSTEM oo 1,932 K
Mamsgs. exe suardinij an 4,868 K
Prinkkey 2000, exe suardinij ] 11,156 K
PrintQueue. exe suardinij oo 6, 700 K o
REvscan.exe SYSTEM oo G,788 K
SavRoan.exe SYSTEM an 1,008 K
setvices.exe SYSTEM i} 2,500 K
SMNSS. EXE SWSTEM oo 80K
spoalsy, Exe SYSTEM oo 1,672 K
sychosk, exe SYSTEM an 1,584 K
swrhnst.mvee SYSTEM i 17,584 K .:i

I show processes from all users End Process I

iPrDcesses: 29 |CPU Usage: 3% \Cormmit Charge: 2078 [ 918M

Verify OUTLOOK.EXE, EXCEL.EXE, WINWORD.EXE and AcroRd32.exe are NOT running.
If any of these items are running, highlight the item(s) and click End Process.
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[ 1. Close all open applications

[ 2. Launch Microsoft® Internet Explorer

Internet
Explorer

| Fle  Edt View Favorites

Qe - - X [s

J Address I@:} hkkps: J vy messur

R r’ Favorites 6-‘”| - -,_-,: E -

j “ Links .’E[ Mexsure g‘] QA Mexsure .é_'] Inktranet

indows Messenger

ahoo! Messenger
LOGIN | SUPPORT | SECUH isualfoute Trace

| ABOUT XDTI | XDTI HOME

Welcome to Mexsure, Please login.
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Internet Options E| [z|

General |Seu:urit_l,l Privacy | Content | Connections || Programs || Advanced |

Haome page
% Y'ou can change which page to uze for your home page.
Address: | kD ) ki, comy |

[ I1ze Current ] [ Ilze Default ] [ I1ze Blank, ]

Temporany Internet files

o Pages you view on the Intermet are stared in a special folder
@& Y for quick viewing later,

[ 4. Click Settings [Betete-Eomtier—--Brictefier—p| Seffings...

Hiztory

] Settings E| [Z|

Check for newer versions of stored pages:
y
& () Every visit to the page
{:} Ewery time wou skark Internet Explorer

() Mewver

Temporary Internet files folder

Current locations  C\Documents and SettingstrohmriLocal
Settings! Temparary Internet Files)

Amaount of disk space ko use:

J =T 192 &| Mg

[ 5. Click View Objects [ Rdcscfcld ] [ bz il »[ Yiew Chjects, ., ]

[ Ok ][ Cancel ]
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[ 6. Right-click and remove WebUpdate Control and xdUpload.Upload.

NOTE: One or both of these components may not appear in this list.

! = ] Serciind lace frestaliedd + 48
| ] etk Aathve® Conlnd Dl alied 1B |
Dedaile X ﬂ‘\ll::m“ Pl Ol [t sl 4TH !

_ - Eiweblipdate Contral < _

Properties

! Open Microsoft® Internet Explorer and log into Nexsure. i

[ Click on Setup

| A e P 12 L e | 1 d i |

© Colwyes Cmmepion Phin Lol Splkend by g8

i Ehmld e bl

i [ Click on Document Templates ‘

3 After a few moments you will see the Document Templates summary screen. ‘
This process loads the WebUpdate Control. Click on the Home link
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[ Click on Interface

WA O AT T | spEns Y

ki B | T P i

i#11.05.04

i M T

L K.

Hals, 1ahn Guaniss

wimdEs  arvisdd peRch

|21 = rhosmg wagm wol ¥ i Bl [10200]

Sl wi Dl L e e dFlafleie Dwimli 1 [ <

Tl Vo B L Dule Wy mpr ey
y -h-I:l-l.aul.- =iy Fisha Ferares

[ Click on Import Files

After a few moments the Exchange Manager will be displayed. Once this occurs, the XdUpload.
Upload will have been loaded.

REchange Manager

Exchange Manager can be used to import quotes and policies into MNexsure.

Satup dirgctanss B impart Gles fram - chek <Satups

H direcbores have alriady been sefup - begin emporting Mles by chcking <Viiow Filies >

] St ] ¥Wirw Files ]
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